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INTRODUCTION 

What is BonsaiBim?  

"The BIM software that helps you work less... and look like you do more!" 

BonsaiBIM is a tool for working with IFC (Industry Foundation Classes) models in 

architecture, engineering and construction projects. What does that mean? That you 

can design, modify, and manage construction information like a pro, without having to 

deal with heavy or expensive software. 
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Purpose of the Manual 

"Because mastering BonsaiBIM should be as easy as pressing a button... 

and not losing your mind in the process!" 

This manual is your guide to mastering BonsaiBIM without losing your patience (or 

humor). Here you will learn from the basics to advanced tricks so that, in no time, you 

will look like an expert in front of your colleagues.  

 

To whom is this document addressed? 

"This manual is for you... yes, there is always something to learn, even 

if you don't know what an IFC is" 

This manual is for: 

▪ Dreamer architects who need to adjust details in their IFC models without 

falling into existential crisis. 

▪ Pragmatic structural engineers , always looking for efficiency (and guilty of 

moving columns without permission).  

▪ Overwhelmed BIM coordinators, who dream of managing models like a ninja.  

▪ And basically, anyone who is curious about the BIM world . 

An important concept 

"A BIM model is not magic, but sometimes it feels like it is... if you know 

how to make it work" 

A BIM (Building Information Modeling) model is a three-dimensional (3D) digital model 

that represents in a detailed and accurate way all aspects of building Project. But it's 

not just a pretty drawing; it is a data management system that includes all the relevant 

Important note: If at any time you feel lost, it's not the fault 

of the manual (obvious), but your lack of coffee. Go make one 

and come back. 
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information: geometry, materials, physical properties, and how the building will behave 

throughout its life cycle. 

In other words, a BIM model is like a gigantic database of what you want to build, 

where everything you need is (if you know how to search for it). You don't have to be 

running around looking for what material it is, how much it costs or whether it has 

been executed or not. Of course, spoiler alert: there is no magic button that gives you 

everything with a single click. Making a complete BIM model, with all that data, 

requires hard work and software to help you manage all that.  

 

Software version  

"Yes, there is always an update, but breathe: it is not that complicated" 

Before you start, make sure you're using the latest version of BonsaiBIM. This manual 

is based on Blender version 4.3 and Bonsai version 0.8.1 (unstable) To check your 

version look at the bottom right of the screen... There are always hints. 

 

Software Installation 

"When installing a program is easier than assembling IKEA furniture (and 

without any leftover screws) 

Installing BonsaiBIM is so simple that even your cat could do it (well, with a little 

help). You have two ways to do this, depending on whether you're connected to the 

internet or if IT is lurking around like hawks.  

Option 1: Direct installation from the browser 

This is the quick and elegant option, perfect if you have internet and there are no 

restrictions on your network (thanks, public cafe). 

Beginner tip: If you're waiting for a BIM model to make your coffee 

and solve your life, you'd better relax. What it will do is make things 

much easier for you... if you put the effort into it. Nothing in life is 

free! 
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1. Go to the Blender extensions page.Don't worry, you don't need a compass or 

map. It's as easy as searching for "BonsaiBIM Blender extension" on Google.  

2. Drag the extension into Blender. Literally, grab the file with your cursor and 

throw it into the Blender window. BOOM!. It's magic, but no bunnies. 

Option 2: For those on a tight IT leash 

Can’t roam freely because IT is watching you like a reality show? No worries, there’s 

a solution for you too: 

1. Download BonsaiBIM from another connection. Go to the same Blender 

extensions page, but this time download the file to your computer (yes, the 

classic method). 

2. Open Blender and go to Preferences > Add-ons. Click the Install from Disk 

button  and select the file you downloaded.  

 

 

 

Once installed, look in the search box of the add-ons window and activate it: 

 

 

 

To get the most out of this tool (and not make a fool of yourself), it is recommended 

to consult the documentation available on the application's website. Don't worry, it's 

not a maze, just follow this magical link: https://docs.bonsaibim.org/. 

 

https://docs.bonsaibim.org/
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Typical Problem: Why won't it open after installation? 

Don’t worry, you’re not the only one who thinks your computer has a personal vendetta 

against you. First things first: close Blender and reopen it. Yes, it feels like magic, 

but sometimes it actually works 

 

Optimization 

"Because a slow Blender is like a car with square wheels: it won’t get you 

anywhere fast" 

To get the most out of Blender, follow these simple tweaks. Don’t worry, it’s easier 

than it sounds—and no, you don’t need to be a computer wizard to pull it off. Ready? 

Let’s dive in! 

1. System Preferences 

Go to Edit > Preferences,  and then click the System tab. You’ve just found the 

control center to unlock Blender’s full potential . 

▪ Enable OptiX: It’s like giving Blender a turbo boost . 

▪ Cycles Rendering Devices: Check all the boxes here, especially the CPU 

and GPU. This lets Blender harness all the power your computer has to 

offer. Don’t hold back—let Blender make the most of it!  

2. Undo Steps 

Nobody’s perfect, and sometimes you make a mistake—like deleting the entire wall 

you just built. Let’s make sure you can undo it. 

▪ Go to Undo Steps and set it to 256. 

▪ This gives you lots of undo options, which means you can go back in time 

and fix your mistakes without worrying about losing everything. It's like 

having a time machine for your work! 

 

Tip: If it still won’t open, take a deep breath, blame the 

software (it’s always the software’s fault!), and head over to the 

OSarch chat for help. They’ve dealt with users on the brink of 

tech-induced breakdowns and probably have the fix. It’s like 

group therapy, but for your tech nerves! 
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3. Online Access 

Blender can use some online resources to make your work smoother.  

▪ Enable Allow Online Access so that Blender can use whatever internet 

resources it needs to improve its performance. It's like letting Blender 

eat all the vegetables to grow strong. 

4. Auto-Save 

Imagine working for hours and then—boom!—your computer crashes (infuriating, 

right?). This is where Auto-Save swoops in to save the day! 

▪ Go to Save & Upload and activate Auto-Save. 

▪ Set the auto-save interval to what feels right for your workflow—

neither too fast nor too slow, just like Goldilocks’ porridge . 

▪ Important: Auto-Save doesn’t overwrite your original file; it saves to a 

temporary folder (like a safety net). If Blender crashes, it'll catch you 

before you hit the ground. But don’t forget to press Ctrl + S regularly 

to save manually. Your future self will thank you! 
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HOW’S THE INTERFACE? 

"Because even the best software needs a guide to avoid getting lost in so 

many buttons." 

In this chapter, you'll learn how to navigate the BonsaiBIM interface like an expert 

(or at least look like one). Its design is designed so that you can work with 3D geometry 

and non-graphic data without going crazy. Let's break it down into parts so you know 

what does what. 

Getting to know the BonsaiBim environment 

"A treasure map to find what you need without asking every 5 minutes" 

The BonsaiBIM interface is organized into three main zones, each with its specific 

function. Think of them as the key pieces of a BIM puzzle. Here's a quick look: 
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Zone 1: The IFC Entity Tree (Left Panel) 

▪ Here you'll find a hierarchical tree that shows all the IFC entities in your 

model, like a guest list for a party... but with walls, windows, and pipes 

instead of people. 

▪ What can you do here? Browse and select any part of the model to edit or 

admire (if you did a good job). 

▪ Quick tip: If you don't find something on your model, it's probably here. 

Use the search engine and save time (and stress).  

Zone 2: 3D Geometry Visualization (Central Area) 

▪ In this zone, you can see the IFC model in 3D, ready for you to play around 

with, analyse and, if you're patient, perfect. . 

▪ You can rotate, zoom, select, and say "aha!" whenever something is 

misplaced. 

▪ Visual trick: In this zone, you can see the IFC model in 3D, ready for you 

to play around with, analyse and, if you're patient, perfect. . 

Zone 3 Non-Graphical 3D Model Data (Right Panel) 

This panel is the brain of the model, where you can view, edit and make sure your 

model is well documented.Everything is divided into tabs that sound important (and 

they are). 

 

 Project Overview   

Welcome to Project Overview, the tab where you can see overall project data without 

having to juggle a thousand tools. Think of it as your roadmap for everything that's 

going on in your IFC model. 

Some of the things you can do: 

▪ Look up general project information (Project Info), such as the project name, 

author and other key data that, while not the most exciting, is what keeps things 

organised (and you from getting lost). 
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▪ Spacial Decomposition A structured map of your IFC model. It's like the list 

of rooms in a video game: you know where everything is and you can move them 

if necessary. 

 

 

▪ Property Sets Templates (Pset): You can generate the templates for all the 

Pset you want to use for each element, you will be more pro than Marie Kondo.  

▪ Georeferencing: If you like your project to be well-placed in the real world, 

this is where you can make sure your model is in the right place on the planet. 

Because, of course, we don't want your building to be floating in space, do we?  

▪ Filter model elements : If you have a giant model and don't know where to 

start, this is your secret tool. Filter elements, find what you need, and organize 

your project like a pro. It's like having an advanced search button, but without 

the need to be a computer genius. 
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▪ Federate models: Do you have multiple IFC models that you need to put 

together in one space? No problem, this tab also allows you to integrate 

different models as if you were creating a mega building project with your LEGO 

blocks. 

▪ buildingSMART Data Dictonary: Translation: An elegant dictionary that 

defines terms and attributes so that everyone speaks the same BIM language.  

▪ Classifications: Enable classifications for elements of the model. Think of this 

as labeling your stuff so you don't mistake a wall for a couch.  

▪  

 

And that's not all. Project Overview does more than just organize things. It's like a 

silent superhero working in the background so that your project stays under control, 

even if you never see it in the action movies!  

 

 Object Information   

The Object Information tab is where you can manage all the details of each element 

of your IFC model. Here you can access the key information of each object and control 

everything related to its structure and properties.  

Some of the things you can do: 

▪ Element data: Get all the information about each object, such as its IFC class, 

which tells you what kind of entity it is (wall, window, column, etc.). It's like 

having a file for each element, with all its details.  

▪ Property Sets (Pset): Property sets are like the detailed characteristics of 

each object. From dimensions to technical specifications, and everything is 

managed here, allowing you to customize the model according to the needs of 

the project. 

▪ Quantity Sets: If you need to know how much material you are going to use or 

make a quick calculation of quantities, quantity sets give you all the information 

you need to make those measurements accurately.  
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In short, Object Information is where you manage and access all the crucial 

information for each element of the model, allowing you to have full control and make 

adjustments or checks with ease. 

 

 Geometry and Materials  

This is the tab where you work magic with your model's shapes and materials. If you've 

ever thought, "How do I make this wall shape, texture, and not look like a Minecraft 

block?" this is the place for you. Let's get to it: 

Some of the things you can do: 

▪ Geometry: Changes the size, shape, and position of any element. Adjust things 

like "that column that was on the right when it should be on the left." It also 

allows you to leave your model like a Gruyère cheese, not smelling bad, but with 

many holes 

▪ Parameterization: If you use parametric models (those that fit like plasticine), 

you can customize dimensions down to the millimeter or also repeat an element 

as many times as you like 

▪ Materials: Apply texture, colour, and physical properties to material. From 

concrete to glass, decide if the walls are rough or shiny, if the ceiling reflects 

light or if you cook in a greenhouse. Define technical properties such as density 

(how heavy it is) or thermal conductivity (whether it retains heat or not).  

In the Geometry and Materials tab you make your walls, ceilings, and columns more 

than just blocks. Here you give them shape, personality and even technical life. It's 

like the model's make-up room, but with engineers clapping in the background.  

 

 Drawings and Documents   

This is the tab where you turn your digital model into drawings, plans, and documents 

ready for printers, demanding bosses, and curious customers. If you've ever been told, 

"Turn that on to a pretty shot," this is where you do it. Let's go with the details:  

Some of the things you can do: 

▪ Create drawings (or the art of impressing the client): Generate 2D plans 

directly from your 3D model, without having to take out the ruler or compass. 

You can take cuts, plan views, elevations and even those sections that no one 

asked for but that still look good. Customize everything: scale, detail levels, 

line weights, and, yes, even colors. 
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▪ Annotate and label: Add dimensions, labels, and explanatory notes to your plans 

so everyone understands what's what. Use tools to indicate materials, 

dimensions, levels, and any technical details. Make every last screw clear so 

that the construction team does not improvise.  

▪ Generate Documents: Export your drawings in popular formats such as PDF or 

DWG to share with the team. Create sheets with your logo, headers, boxes and 

all the official paraphernalia that makes your plans look pro. Organize 

everything into sets of drawings so they're ready to print or send to the client.  

In the Drawings and Documents tab you pull out the drawings and documents of the 

model like a chef pulling out a gourmet dish: quick, clean and ready to impress. All 

organised, clearly labelled and error-free, because nobody wants to explain why a door 

was left where it shouldn't be.  

 

 Services and System 

This is the tab where the building's "systems" come to life. This is where you control 

everything that is not the walls or ceiling, but which, equally, are essential for your 

building to run like clockwork. Think of electricity, plumbing, heating, ventilation... and 

no, it's not magic, it's engineering! 

Some of the things you can do: 

▪ Define and manage systems: Create and manage all the building's technical 

systems: electricity, HVAC (heating, ventilation, and air conditioning), plumbing, 

fire alarms, etc. Each system can have its own set of properties and technical 

specifications so that everything fits perfectly into the design. You can see how 

the different systems connect to each other. It's like throwing a party: you 

need to know how the speakers connect to the lights and food so that everything 

doesn't fall over. 

▪ Assign Computers and Devices: Assign all the equipment and devices needed 

for systems to work. This includes fans, pumps, plugs, thermostats, and more. 

Each of these devices is strategically placed so that the system works without 

overloading anything. You can also check their specifications so that, for 

example, the plugs are correct for each type of device. 

In the Services and Systems tab, you not only make sure your building looks good, you 

make sure it works. You organise everything from the electricity to the ventilation 

systems, making sure that the pipe doesn't cross the cable or that your building 

doesn't turn into a fridge. All well planned and connected, like clockwork.  
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 Structural Analisys 

This is the tab that shows that the model is not only beautiful, but that it can 

withstand whatever is thrown at it. 

Some of the things you can do: 

▪ Define loads and forces: Load means the weight and forces that the building 

has to support: people, furniture, wind, snow, earthquakes... everything that can 

make the building say, "Oh, that's heavy!" Here you define those loads and 

distribute the forces on the structures, such as beams and columns, so that 

everything is balanced and there are no surprises later. You can also set 

boundary conditions to let the building know what's around it.  

The Structural Analysis tab is where your building undergoes an endurance test. It's 

like a strength test at the gym, but without the sweat. Here you can see if 

everything's balanced, if the forces won't wreak havoc on the columns, and if your 

design can withstand storms, winds or an army of penguins. All to make sure that when 

the time comes to build, it won't collapse before its time. 

 

 Costing and Scheluding 

The tab where you turn your building dreams into budgets and calendars! If you've 

ever heard someone say "money doesn't grow on trees," this is the section where you 

make sure you don't spend your entire budget on a gold wall or a marble pool. Here you 

manage money and time, two of the most precious resources in any project.  

Some of the things you can do: 

▪ Set the budget: Here you can define the cost of each material and work involved 

in the project. The tab helps you calculate how much everything from concrete 

to electrical wiring is going to cost without having to pull out the calculator (or 

cry in the process).  

▪ Create the schedule: Define the start and end dates for each phase of the 

project: from excavation to installation of the lamps. You can assign specific 

tasks to workers or contractors, making sure everything is ready on time and 

without headaches. Visualize the schedule on a timeline (it's like having a giant 

calendar screaming at you when something is late!).  

▪ Progress Tracking: Track in real-time how the project is progressing. Is the 

plumbing contract overdue? Is the masonry team ahead of schedule? Here you 

can see everything. You can compare actual progress to planned progress, to 
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make sure everything is going smoothly, or make adjustments if you're falling 

behind. 

▪ Resource forecasting: This tool allows you to calculate how much material you 

will need in each phase of the project and when. It makes sure that you are 

never short of materials in the middle of the work (or that there is so much 

left over that you have to return an entire truck of cement). 

The Costing and Scheduling tab is where you turn your cool design into economic and 

temporal reality. Here you can adjust your budget, organize your time, make sure 

resources are used efficiently and that your project doesn't fall through the cracks. 

This way, you not only ensure that your building stays standing, but also that you make 

it to the end of the project without ending up selling your car to cover the costs. 

 

 Facility Management 

Do you know those buildings with the broken systems, flickering lights or plumbing 

that sounds like a horror movie? Well, with this tab, that's a thing of the past! This 

is where you become the maintenance superhero, making sure your building continues 

to function perfectly even after you've handed it over. It's like having a virtual 

assistant take care of all the post-construction care! 

Some of the things you can do: 

▪ Manage maintenance: You can create and manage maintenance schedules for all 

systems and equipment in the building (the kind where you tell yourself, "I'll do 

it tomorrow"). Define when inspections and repairs should be performed: Every 

month, every year, or as soon as you hear a strange noise in the air conditioner? 

Keep everything organized so that systems keep running without surprises (like 

the elevator not working when you need it most). 

▪ Control assets and inventory: Keep track of all equipment and facilities in 

the building: from appliances to HVAC systems. Keep an inventory of parts and 

materials so you never run out of tools when you need them most. And you can 

know exactly where those extra bulbs or that special faucet you need to fix 

everything are! 

The Facility Management tab is your secret weapon when it comes to keeping your 

building in top shape. You're the boss, calling the shots on repairs, replacements and 

materials inventory. You're in control the whole time, scheduling maintenance, keeping 

performance high and making sure everything keeps running like clockwork. Your 

building stays in mint condition, and you're the hero of the building maintenance world.   
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 Quality and Coordination 

This tab is like your personal workshop for tuning IFC models. Here you'll find 

essential tools that will make your life easier, from extracting data to merging 

projects to adjusting sources (all in a couple of clicks).  

Here are some of the things you can do: 

▪ Debug models: Organize and clean up your model to make it more efficient 

and manageable. 

▪ Small programs that will help you in things with element extraction, element 

data, merging... 

▪ Clash Detection: Detect those clashes between elements that could ruin the 

project (or your reputation). 

▪ BCF file management: These files are like your GPS: they guide you directly 

to the problems in your model, straightforwardly.  

Getting Started: Opening and Exploring an IFC 

Model 

"Because the first thing is to open the file... and then not lose yourself 

in it" 

OPEN AN IFC FILE 

1. Go to the File tab  (yes, the one that seems obvious but we never use it until 

we need it). 

2. Haz clic and Open IFC Project. 

3. Select your IFC model and... voilà! You now have the BonsaiBIM model ready to 

be explored. 

 

CREATE AN IFC FILE 

1. Open Blender and go to the File tab > New. This creates a blank file where you 

will start your BIM journey. 

2. Once you have the file, open the Project Overview tab  in the Bonsai extension 

and select the IFC 4x3 scheme. 
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o Why IFC 4x3? Because it is the most recent version and optimized to 

work with updated standards. 

 

 

              

 

Just a heads-up: if you open an IFC file straight from 

File, Blender will use the IFC 4 scheme by default. This 

isn't a bad thing, but it's not ideal. The better option is 

to create the new file in Blender and select IFC 4x3 

manually. 
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IFC DESIGN & EDITING  

" Hands on: create and modify your model like a BIM master" 

In this section, we're going to take a look at how to create your IFC model from the 

beginning. And if you're like us, you'll probably want to modify those elements that 

didn't turn out the way you expected (because, let's face it, that's half the fun). So 

get your virtual helmet on and get ready to build and tweak like a pro.  

Introduction to design 

You've already installed Blender, added the Bonsai extension, and now you're in front 

of a jungle of buttons that seem more mysterious than a secret recipe. Don't worry, 

here we start shaping your model step by step.  

Exploring the Bonsai pop-up 

In zone 2 you will find a drop-down full of icons. Each represents a  predefined 

IfcElementType (such as walls or windows).  

These elements are the basis. You shape them geometrically and they automatically 

become the IfcElement you selected. 

This drop-down is mainly aimed at building elements, but if you are looking for 

something more generic, you can also create it  
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Creating Generic Elements  

Go to the Definition section. Here you select the entities that will classify your 

object. 

 

If you doubt about any entity, put the cursor over it; An explanation will appear 

(although sometimes you'll need your imagination to figure it out).  

 

In Class, you'll sort your object within the chosen entities. Everything is sorted 

alphabetically so you don't go crazy searching.  
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What about representations?  

In the Representation section, you decide what your object will look like. You can 

choose between: 

 

 

1. No Geometry: The object doesn't have a graphical representation, making it perfect 

for information elements. 

2. Tessellation From Object: You can use an object made in Blender, which is great 

for custom designs like beams or gutters or hyperbolic cosine walls. 
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Important Tip: After modifying your object in 

Blender, press Ctrl+A and select Apply All Transforms 

to avoid future problems. 
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3. Custom Tessellation: More advanced and personalized representation. 

 

 

 

 

4. Custom Extruded Solid: Useful for linear shapes that need extrusion.  

 

 



           Bonsai for dummies 

24 

 

 

 

Contexts: The last step of the drop-down 

This is the closing of the definition process. Here you decide the context in which 

your object is used. 

 

Sometimes, words just aren't enough – you need to see how it's done. So here's the 

ideal video for you! It's like watching a movie, but with less popcorn and more 

productivity. This video will show you how to define your building step by step, and 

best of all, in a very professional and easy-to-follow format. So, while you're enjoying 

your coffee, click on this link and in no time at all, you'll know how to add and organize 

everything like a real expert. 

This video is a game-changer! Watch Video Tutorial 

https://www.youtube.com/watch?v=pQnJ-5b3_Kg
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Modifying data: because changing your mind is 

also design 

"The great thing about BIM models is that you can always tweak things… 

as long as you know where to look" 

Sometimes we need to modify the data of our elements. It may be because we make 

mistakes, because we think better of it, or simply because we feel like it. The good 

thing is that Bonsai is prepared for these moments of reflection (or chaos).  

From the Object Information tab, in the Object Metadata drop-down, you can do the 

following: 

 

• Reassign IFC classification: If your item needs an identity change, this is the 

place. 

• Modify attributes such as name or type : Because calling it "Muro_01" is not 

very inspiring, right? 

• Change its spatial container: If you need to move it to another level or section 

of the project, use Spatial Container. 

• Edit Pset generated by us: This is a bit of a spoiler because we'll get to it 

later, but yes, here you can adjust that custom data that you created. 
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Modifying and editing IFC elements 

"Because mistakes are part of the design, and so are editing them" 

Editing an IFC model might feel like a marathon, but don't worry, we've got you 

covered with a few essential tips to make this process as smooth as possible . 

Changing the position:  

• Go to the Geometry and Materials tab. 

• In the Placement drop-down, you can adjust the position or rotation of the 

object. 

Philosophical note: Changing data is like redoing a sketch. It's 

fine to do it, but make sure you don't mess up the rest of the 

model in the process. 
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• Prefer visual focus? Use Blender's Gizmo to move the object, but remember 

to check the Placement dropdown to see that the movement is reflected there. 

Otherwise, it's as if you haven't done anything.  

 

 

Modify the geometry  

First, select the object you want to modify:  

• Go to the IFC Object Mode drop-down  and select IFC Item Mode. 

 

 

• Select the object again, and from the same drop-down, select IFC Edit Mode. 
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• Ready to edit! 

 

 

 

 

 

 

 

Vital note: Make sure you edit in IFC Object Mode, not the 

standard Blender editor. Otherwise, your changes might be 

saved as a memory, but won't be part of the IFC model.  
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How to Make Holes in Your Design Without Making a Hole in Your Sanity 

So, you forgot to add a door to that "award-winning" terrace design, need to connect 

plumbing between floors, or want a neat little hatch in a slab? Well, don't worry, 

you're not alone. Here's a simple guide to creating holes that even your mum would 

approve of. 

Method 1: Using Voids (The Posh Way) 

This is the "official" method—clean, precise, and ever so proper. Follow these 

steps: 

1. Summon the Void 

Go to: Menu > Add > Ifc Element > Opening . This essentially creates a 

placeholder for your hole. Fancy, isn’t it?  

 

2. Shape Your Void 

Adjust the Opening Element to match your desired shape and size. A circle? 

A square? A doughnut? It's your masterpiece—don’t let anyone tell you 

otherwise. 

 

3. Apply the Void to Your Object 

o First, select the object you want to bore through (a wall, a slab, or 

that mistake you call a floor). 

o Then, select the Opening Element. 

o Head over to Geometry and Materials, find the Geometric 

Relationships dropdown, and choose Voids > Add Opening. 
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Congratulations! You've just added a hole the Queen herself would admire 

(probably). 

 

 

Method 2: Boolean Magic (The Hands-On Way) 

If you're more of a "let me do it myself" kind of person, this one's for you. Think 

of it as sculpting with Blender—only less artistic and more destructive.  

1. Craft Your Cutter 

Create a shape in Blender—be it a cylinder, a cube, or something avant-

garde. This is your hole maker. 

2. Choose Your Victim and Weapon 

o Select the cutter (your weapon of choice).  

o Then, select the object you want to perforate (your victim, poor 

thing). 

3. Slice and Dice 

o Navigate to Geometry and Materials. 

o Under Geometric Relationships, pick Booleans > Add. 

And there you have it—one perfectly good object now ruined... but in 

the best way possible. 
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:Save your work before creating chaos. Nothing screams "rookie mistake" louder than a 

misplaced hole you can’t undo.  

• Be patient. Rome wasn’t built in a day, and neither was your questionable design. 

Take your time to make sure the hole is where it should be (and not in your ego).  

 

 

Pset: Add, Modify, or Remove Property Set 

"Because without the right properties, your BIM model is just an empty 

shell" 

What are Pset? The literal translation is "Property Sets." Basically, they’re the data 

attached to the elements in your model. We’re not talking about shapes or dimensions 

Pro Tips for Hole Enthusiasts Always save your work before 

diving into the abyss of hole-making—nothing’s worse than an 

accidental void in the wrong place. Take your time, double-check 

your placements, and remember: precision now saves 

embarrassment later. 
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here but about the characteristics that describe how they behave or what 

specifications they have.  

There are different types of property sets in IFC, which are generally grouped into 

two categories:  

1. Standard Psets: Defined by IFC standards and widely accepted by the AEC industry. 

For example: 

Pset_WallCommon (for walls). 

Pset_WindowCommon (for windows). 

Pset_SpaceOccupancyRequirements (for space occupancy requirements).  

3. Custom Psets: Created specifically for a project or company, adapting to 

particular needs, let's go the ones that you (or your team) invent for specific 

needs.  

So why do we need Psets? Basically, for two things  

- Standardization: Ensures all your projects follow the same logic and structure.  

- Ease of analysis: Need to filter specific elements? Without custom Psets, you'd be 

sailing in a sea of data without a compass.  

 

 

Now let's see how these Pset are introduced into our model.  

To add user-defined Pset (that's you) the first thing you need to do is create them, 

you have to go to the Property Set Templates tab: where you create a custom 

property set template (Pset) to adjust them to the needs of each user.  

Note with love Don’t try to fill your model with Psets “just 

because it sounds good” or to impress your boss. A model with 

more Psets than necessary is like a backpack full of useless stuff: 

heavy and impractical.  
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It is important to know that you can apply the Pset to the entity you want, for example 

if there are some Pset that are for the project in general, you have to indicate it in 

It's important to know that you can apply Psets to any entity you want. For example, 

if there are Psets for the project as a whole, you need to specify it under 

ApplicableEntity: 

 

 

 

 

 

Tip: If you need to add specific properties, save them in this 

path: C:\Users\user\AppData\Roaming\Blender 

Foundation\Blender\4.2\extensions\.local\lib\pyth

on3.11\site-packages\bonsai\bim\data\pset. 
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These properties can be reused in other projects that require them. Do you have any 

questions? Watch this tutorial: YouTube 

Introduce Pset: One by One or in bulk 

If you’re modeling from scratch and you’re the organized type (you don’t leave 

everything for the end), you can introduce Psets into each element one by one. Here’s 

how to do it: 

1. Go to the Object Information tab. 

2. Open the Property Sets drop-down . 

3. Select, within Custom Pset, the template you’ve already created.  

4. Fill in the values of the properties you included in your template  

 

 

This process is ideal if you're meticulous and like to go step by step, or if your model 

is still in diapers. Ah! And it works the same for the IfcProject entity 

https://www.youtube.com/watch?v=nlSM593swZY
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What if you have hundreds of identical elements?  

This is where the bulk method comes in, because no one has time to go one by one 

when the clock is ticking. 

1. Go to the Object Information tab. 

2. Go to the Misc. (miscellaneous) drop-down and select Bulk Property 

Editor. 

3. From here you can: 

Rename properties: Change the name of the properties, but not 

their values. 

Add or edit properties: Enter the name of the Pset, the property, 

and the value. Also, remember to specify the entity type you used 

in your template. 

Remove properties: Get rid of the ones you no longer need.  

4. Select all the objects you want to apply these changes to.  

5. Click Apply Changes. And you're done! 
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Important warning: If you edit properties, the object will only keep the properties 

you list. So, if you lazily decide to include just one, the rest will disappear. Better 

make sure you include everything you need.. 

...... And one more thing, renaming is just for changing the property name. If you 

need to edit the values, you'll have to go through "Edit." Do it right, and your model 

will thank you. 

 

 

Georeferencing (WIP) 
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IFC MANAGEMENT  

" Master your IFC model and turn it into a well-organized masterpiece (or 

at least, something that doesn’t give you a headache).” 

Welcome to the section where you learn to take full control of your IFC model. Here, 

we’ll dive into organizing, filtering, federating, and even solving those tiny issues that 

sometimes make you want to toss your computer out the window. Take a deep breath , 

and let’s get to work! 

(Re)Organizing Your Model 

Having a correct IFC schema in the model you're working with not only makes the data 

easier to manage, but also allows you to reuse it efficiently. This speeds up 

construction design and planning, reduces development times, minimizes last-minute 

changes, and improves overall project quality.  

 

Where Do I Begin? Back to Zone 1, My Friend 

Remember Zone 1? Time to revisit it, because that’s where all the action begins.  

There are two main types of things to edit:  

• Containers (like IfcBuilding, IfcRailway, IfcBuildingStorey, or 

IfcRailwayPart) 

• 3D Objects (like IfcDoor, IfcSlab, or IfcFooting) 

To edit them, you’ll need to hover over the specific element. But here’s the catch: if 

you want to tweak a container, you’ll need to start with the null element (the one with 

the funky three-line symbol that looks like a futuristic emoji).  
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And Now, On to Zone 3 

Navigate over to Project Overview → Spatial Decomposition. This is where you’ll find 

the famous hierarchy tree. Think of it as an org chart, but for models (and way less 

boring). From this tab, you can: 

• Add new levels (handy if your building suddenly decided to grow a few extra 

floors). 

• Remove levels you no longer need (bye-bye clutter!). 

 

 

 

Switching Entity Types 

Need to give something in the hierarchy tree a new identity? Head over to Object 

Information → Object Metadata. Pick the element you want to tweak, and voilà:  

• Reclassify it to fit its true purpose. 

• Rename it straight from the Attributes section (because no one wants a 

model full of "Object.001" chaos). 
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And What About Those 3D Objects? 

Got a rogue 3D object with no proper mapping? Fear not. Click the "▽" symbol in Zone 

1, and watch as your object magically lights up in Zone 2. From there, Zone 3 is your 

playground: 

• Assign it the correct IFC class (finally, some structure!). 

• Rename it to something sensible. 

• Place it on the right level in the hierarchy tree. 

• Add or fine-tune its properties. 

It’s like giving your model a well-deserved spa day. 
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Pro Tip: Keep your hierarchy tree neat and tidy. Think of 

it as your digital filing cabinet: the clearer it is, the less 

likely you are to lose your mind while working on your 

model. 
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Filtering Elements 

As we mentioned earlier, one of the main perks of a BIM model is the treasure trove 

of information it holds. And just like you’d filter a 20,000-row Excel spreadsheet, the 

best way to find what you need here is to apply filters.  

BonsaiBIM comes with some pretty cool filtering tools. To get started, head to the 

Project Overview tab and open the dropdown Grouping and Filtering. Here, you’ll find 

a variety of options: 

• Search: This lets you search for elements based on their classification, 

material, Psets... basically, whatever you need.  

Let’s take a look at a couple of examples, like searching for elements by classification 

or those custom Psets you painstakingly created (because let’s be honest, they deserve 

to shine). 
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Filter Selection: This one’s all yours to play around with... it’s pretty straightforward, 

promise. 

Color By Property: Now, this is my personal favorite (I admit it, I’m a sucker for 

colors). It lets you see all the elements color-coded based on their classification—

practical and pretty! 

 

SuperTip If you've classified it as ifcBoolean, it will 

need to be either TRUE or FALSE (and yes, the capital 

letters are very important) 

For its correct syntax it is recommended to see: 

https://docs.ifcopenshell.org/ifcopenshell-

python/selector_syntax.html 

https://docs.ifcopenshell.org/ifcopenshell-python/selector_syntax.html
https://docs.ifcopenshell.org/ifcopenshell-python/selector_syntax.html
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And now with our Pset, you can make Colour by the drop-down you want 
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Federate and Merge 

 "Aren't they the same? Nope, and here's why" 

Federating means bringing multiple models into one workspace, but without combining 

them. Think of it as working in a team: each model stays independent. It's like a football 

match: you’ve got the forward (architect), the midfielder (structural engineer), the 

defenders (mechanical engineer), and the goalkeeper (electrical installations). Each one 

plays their role, contributes their "model" to the team, and works together to win. If 

something doesn’t fit (like a missed pass), you can adjust it easily because each player 

remains independent. 

On the other hand, merging combines everything into one file. It’s ideal when you need a 

single, final file to share with others. Now imagine deciding to merge the team into one 

super-player. You take the forward, midfielder, defender, and goalkeeper and put them all 

together into one entity, thinking, "This will save time!" But soon, you realize the result is 

a bloated model: heavy and slow. In the end, instead of a functional team, you’ve got a 

Frankenstein’s monster that makes even opening the file feel like a Herculean task.  

 

 

 

To federate in Bosai: 

In the Project Overview tab, in the Project Setup drop-down, use the Link tool, which 

allows you to combine and integrate multiple IFC models into a single workspace, 

making federation and coordination between different parts of the project a breeze . 

 

 

👉 BIM lesson Federating lets you collaborate quickly 

and make adjustments with ease. Merging may seem like 

a shortcut, but it can turn into a heavy, error-prone 

monster. Best for those who just want a single model... 

but beware of the bloated file! 😬 
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To merge, here things get complicated, just a little:  

You have to go to the Quality and Coodination tab, go to the Patch drop-down, choose 

from the Recipes: MergeProject drop-down. At this point it is important to be clear 

about which file we want to merge the ifc into, which if you select Load from Memory 

will use the model you are working with, if you want another one choose IFC Patch 

Input IFC. 

We generate a new file that we have to indicate the path, as well as the name, that 

you don't forget to put .ifc. And then you select the files you want to merge into 

filepaths... You press the little button and that's it.  

 

 

Data and Element Extraction (WIP) 

 

Generate 2D documents (WIP) 
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QTO (Quantity Take-Off) (WIP). 

 

Working with large models (WIP) 
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CONCLUSION: DID YOU MAKE IT? 

TIME TO CELEBRATE WITH A 

COFFEE AND YOUR PERFECTLY 

DONE BIM MODEL! 

And there you have it! Managing IFC doesn’t have to be 

intimidating. With these tools and tips, you can take control 

of your models and work like a true BonsaiBIM pro. The 

secret? Stay organized, filter out what you don’t need, and 

remember: if you get stuck, there’s a tutorial for 

everything. 
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